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Preface

Training Session Goal

In this training session, you will explore the teacher tool set available in PowerTeacher. You will
learn to take attendance and submit lunch counts, set up the gradebook, and manage
assignments and scores. You will also learn how to submit student log entries, enter comments
for parents, print reports, and access student information.

Objectives

At the end of this session, you will be able to:

* Use PowerTeacher to take attendance and record a lunch count
e Set up PowerTeacher gradebook

e Enter assignments and record scores

e Set up student groups

* Analyze classroom achievement trends

e Submit student log entries

e Enter comments for parents

* Print PowerTeacher reports

Preface Copyright © 2007 Pearson Education, Inc or its affiliates.
All rights reserved.



PowerSchool PowerTeacher

Welcome to PowerTeacher!

PowerTeacher is an essential part of the PowerSchool Student Information System (SIS). With
PowerTeacher you have access to your gradebook and other student information from any
location with an Internet connection. All the information you need to get started — such as
student schedules and demographic information stored in the PowerSchool database -- is
available via your PowerTeacher login. Similarly, the information you enter in to PowerTeacher
is dynamically uploaded to PowerSchool so that it's viewable by PowerSchool administrators,
teachers — and, at your discretion — to parents and students.

PowerSchool helps your school collect, maintain, and analyze student, staff, and schedule
information. PowerSchool is a database application that runs on a server, and is the center of
your student information system. It uses the Internet to facilitate student information
management and communication among school administrators, teachers, parents, and
students. Each of these groups has its own "doorway" or access to the PowerSchool SIS. The
teachers' access, PowerTeacher, provides features and functions tailored to duties and
responsibilities teachers handle day-to-day.

The PowerTeacher gradebook provides a flexible solution to a variety of gradebook dilemmas.
By using PowerTeacher gradebook you can:

* create categories for assignments you expect students to complete during the term
* weight assignments to adjust their impact on a term grade

e conduct basic statistical analyses of students' performance on class assignments

e compare individual student progress to whole-class performance

e evaluate the effectiveness of a single assignment or an entire assignment category
e calculate student term grades continually

e produce progress reports whenever students need them

* publish reports to facilitate analysis of student achievement

Substitute teachers access PowerSchool Substitute using a web browser. In your absence,
substitutes enter attendance in each of your classes without directly changing your gradebook
information. When you return to school, the attendance taken by the substitute automatically
appears in your gradebook.

Similarly, parents or guardians and students can access PowerSchool Parent Access using a
web browser. They can view grades, assignments, teacher comments, the school bulletin, and
student fee balance information. In addition, parents or guardians can request automatically-
emailed student progress reports.

Welcome to PowerTeacher! Copyright © 2007 Pearson Education, Inc or its affiliates. 7
All rights reserved.
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Overview of PowerTeacher

PowerTeacher provides access to the gradebook, to attendance information, to a recording
lunch count function, to general student information, and to school reports. You can use
PowerTeacher anywhere you have access to the Internet.

Getting Started

To log on to PowerTeacher, you need the following information from your PowerSchool
administrator:

Address of your PowerSchool server (Such as https://pslupinhillselem.org/teachers)
* Your username and password (lastname_initial; 25139)

Log on to PowerTeacher

1. Open a web browser, such as Safari, Netscape Navigator, or Internet Explorer, and
enter the address of your PowerSchool server followed by /teachers in the browser
address bar.

Enter your username and password.

Click Enter.

When you are ready to log off PowerTeacher, click the Logout button in the upper right
corner.

roON

The PowerTeacher start page consists of three areas:

* Navigation Bar — located at the top of the screen. The Navigation Bar provides access
to the Start Page (via the PowerTeacher logo), the Report Queue, Online Help, and the
Logout Button.

* Main Menu — located at the left side of the screen. The Main Menu provides access to
the Start Page, the Daily Bulletin, a display of your Meal Balance, the Staff Directory, the
Gradebook, and Reports.

e Current Classes — located in the center of the Start Page screen. The Current Classes
area provides access to information regarding the students in the classes you teach, as
well as to the tools for attendance, lunch count, and reports.

Overview of PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates.
All rights reserved.
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PowerSchool

Hands-On Activity

1. Click through the buttons in the main menu to familiarize yourself with some of the
functions of PowerTeacher.

2. Click the PowerTeacher logo or the Start Page tab to return to the Start Page.

Overview of PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 9
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Using PowerTeacher in the Classroom

You can use PowerTeacher on a daily basis to help you manage your students’ information.
PowerTeacher makes it easy to take attendance, record meal requests, look up staff email
addresses, manage grades, and print reports.

Taking Attendance

It is easy to take attendance in PowerTeacher. As soon as you take attendance, the information
is available to school administrators, parents, and students.

1. From the PowerTeacher Start Page, click the chair icon next to the class for which you
want to take today’s attendance. PowerTeacher defaults to today’s attendance. If you
need to take past or future attendance, change the date in the menu next to Record
Meeting Attendance in the top center of the attendance window. (Note that if you are in
a school that has A days and B days, for example, only some of the chair icons will be
clickable. It is not possible to take attendance for a class that is not in session that day.)

2. Select the appropriate attendance code from the menu above student names to
indicate which students are absent or tardy.

3. Click the cell next to an absent or tardy student’s name to assign that code.

4. Click Submit to save the attendance record.

Record Meeting Attendance | Mon 7/23 (Today) ~|
Record MultiMeeting Attendance for Multiple Sections

First Aid - 1(A)

Current attendance code: : A (Absent) iv|

Bowles, BenC ‘
Burleigh, Heather D ‘7
Henderson, Daniel S ‘
Johnson, Lloyd U ‘*
Meredith, Cade F S - School Excused
Ruziska, Nicholas C \

Thomas, Evan P ‘

Yalenzuela, Cheyenne P

£ Submit Y

- Mot enrolled

Note: If all of your students are present, you will still need to click on the chair icon to open the
attendance screen, then click Submit to save the attendance information. Doing so indicates to
PowerSchool that you have taken attendance and all students are present.

Using PowerTeacher in the Copyright © 2007 Pearson Education, Inc or its affiliates. 10
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If you teach more than one class during the same period, you can take attendance for all of the
students in your classroom at the same time by clicking Record MultiMeeting Attendance for
Multiple Sections at the top of the Record Meeting Attendance page.

Taking Lunch Count

1. On the Start Page, click the utensil icon next to the class for which you want to submit a
lunch count.

2. Enter the total count for each applicable item, and click Submit.

Submit Lunch Counts

Student Breakfast ID Adult Breakfast |0

Student Lunch 18 Adult Lunch

Student A La Carte |D Adult A La Carte
Milk. |1 ] Other 1

(NN

Other 2
€ Submit

Hands-On Activity
Take attendance for today in PowerTeacher.

1. Click the chair icon next to one of your classes.

2. Select an attendance code from the list.

3. Mark attendance for your students.

4. Click Submit to save the attendance data.

Using PowerTeacher in the Copyright © 2007 Pearson Education, Inc or its affiliates. 11
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Working with PowerTeacher Gradebook

Launch the Gradebook

1. Navigate to your PowerSchool server address and log on to PowerTeacher using the
username and password you were assigned by your PowerSchool administrator.

2. Click the Gradebook tab in the Main Menu on the Start page.

3. The PowerTeacher Gradebook Launch page appears. Click the Launch gradebook
button.

4. As the program launches, a dialog box will appear asking you to “Trust” a certificate.
Click the Trust button.

5. PowerTeacher gradebook will open.

6. When you are ready to quit using the gradebook, navigate to the PowerTeacher
Gradebook menu at the top of your computer screen and click Quit PowerTeacher
Gradebook, or simply click the close button in the gradebook window.

Notes:

* |f you get a Java error, download the latest version of Java and try launching the
gradebook again, or contact your PowerSchool Administrator.

* |f you attempt to open a second session of PowerTeacher gradebook, a dialog box
indicating that a PowerTeacher gradebook session is already in use will appear. You
will be able to choose to end the first session and continue logging in to the second
session, or to quit launching the second session. (This situation may arise when you
have been working at school without quitting the gradebook, then launching the
gradebook from home on a different computer.)

* |f you have been logged in to the PowerTeacher gradebook and been inactive for a
length of time (typically 20 minutes), a dialog box asking for your password will appear
on the screen. Type in your password, and you will be logged back in to your
PowerTeacher gradebook session.

The PowerTeacher Gradebook Window

By default, the PowerTeacher gradebook opens to the Scoresheet tab, a modified spreadsheet

through which you will track student assignment scores. A set of six icons is displayed near the
top of the PowerTeacher gradebook window: Scoresheet, Assignments, Students, Grade Setup,
Class Info, and Reports. These icons will allow you to navigate through your gradebook.

* Scoresheet - displays the assignments and scores you have entered for the students.

* Assignments - displays the assignments you have created and information about what
kind of assignment each is, when each is due, and how many points each is worth.

* Students - contains demographic data for each of the students in your classes.

* Grade Setup - displays the final grade setup for each term.

* Class Info - contains the basic information about the course you selected in the Classes
pane.

* Reports - provides an easy-to use interface through which you can designate how you
want a report to run.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 12
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The Scoresheet window.

Setting up the Gradebook

The PowerTeacher gradebook is configured for immediate use. If you want to practice using it
without going through the setup process, you can: it is fully functional. You can begin work as
soon as student lists appear in the gradebook once the schedule is committed.

The default settings for the gradebook establish the final grade setup as being total points and
establishes four types of assignment categories: homework, quiz, test, and project.

However, if your personal preference or school policy dictate that you configure the gradebook
in a particular way, you can follow the procedures outlined below to customize the gradebook.

Setting Up Categories

Categories are broad classifications in which similar types of assignments are grouped. Daily
assignments, tests, and quizzes could each be considered an assignment category.

The PowerTeacher gradebook comes with four pre-defined category types: Homework, Project,

Quiz, and Test. You can add more categories and modify these as you need to meet the needs
of your classroom.

When you create a category for your assignments you will define several pieces of information
about the category: abbreviation, points possible, and score type. During the term, when you
create an assignment and choose a category, the information you previously defined will

become the default for the assignment. This information can be modified for individual
assignments.

Working with PowerTeacher
Gradebook

Copyright © 2007 Pearson Education, Inc or its affiliates.
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Score type indicates to PowerTeacher gradebook how you would like scores displayed on the
Scoresheet — as Points, Percentages, or Letter Grades. Your school or district may have a
policy about how grades are to be displayed in a gradebook. If so, use that policy as a guide
when creating categories. If your school or district has not instituted a grading policy, you may
wish to spend some time considering how you want your PowerTeacher gradebook set up.
Think ahead to how you expect to use your PowerTeacher gradebook and then modify the
Score Type for each category so that the PowerTeacher gradebook is set up to best meet your
needs. One principle that holds true is that keeping the score type for all categories the same is
the simplest solution, both for entering scores and for interpreting the results.

Creating a New Category

1. Click the Tools menu at the top of your screen, and select Categories. The Categories
window will appear, displaying the pre-defined assignment categories.

2. Click the Plus (+) button in the lower left-hand corner of the Categories window to add a
new category.

3. Use the table below to enter information in the fields:

Name Type the name you would like to use for the category.

Abbreviation Enter an abbreviation to stand for this category.

Choose the color you would like to use for the category on the

Color Scoresheet.

If there is a typical number of points possible for the category,

Points Possible enter the points possible.

Score Type Choose the score type for the category.

Very important! Select the checkbox if scores for assignments
in this category are to be used in the calculation of the final grade
Include in Final for the course.

Grade If this box is not checked, the scores won't count, which is great
for an assignment like "turn in permission slip," or "reading
diagnostic," but not appropriate for daily student work.

Enter a description for the category. This description will be
Description displayed in the Administrator and Parent Access areas of
PowerSchool.

4. You can continue to add categories by clicking the Plus sign, or you can modify an
existing category by changing the default values in each of the fields.

5. When you have added all categories or completed making changes, click Close to close
the Categories dialog box. The categories will be saved.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 14
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Note: these categories will be available to all of the classes or sections you teach. If you
teach a variety of topics, each requiring different categories, simply use the categories you
need. Unused categories have no impact on student scores or grades.

Hands-On Activities

1. Scroll through the default categories:
* How many points is each assignment in each category worth?
* Are scores to be recorded and displayed in points, percentages, or letter grades?
* Are scores to be included in the final grade?

2. Add two categories of your own to PowerTeacher gradebook.
* Click the Tools menu at the top of your screen, and select Categories. The
Categories window will appear, displaying the pre-defined assignment categories.
* Click the Plus (+) button in the lower left-hand corner of the Categories window to
add a new category.
* Enter information into the appropriate fields.
* Click the Plus (+) sign to add the second category.

* Click Close to close the Categories dialog box.

3. Enter the categories you use in the following table. This will facilitate an easy setup of
your gradebook next year.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates.
Gradebook Al rights reserved.
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Setting Up Final Grade Weighting

After you create assignment categories, you will need to determine how your students’ final
grades will be calculated for each term. You have several options for final grade calculations:

e Total points
e Term weights
e Category weights

Total Points

The Total points option is the most straightforward method of calculating the final grade for the
term. When you use this method, the student’s final grade will be calculated based upon how
many points the student has accumulated divided by how many points are possible.

Total Points is the default setting for all terms. If you need a different method, you will need to
set up each class.

Term Weights

A second way to determine the final grade is to use Term weights. When you use this method,
you will be multiplying the total number of points by the value (or weight) of each term. For
example, you might have Semester 1 worth 40% of the final grade and Semester 2 worth 60%.

Simple solutions are the best to use whenever possible, because they are the easiest to
interpret and explain. For example, a straightforward plan to have Quarter 1 and Quarter 2 each
count 50% toward the final semester grade is easily understood.

It is possible to have a final exam count toward a semester grade. One way to do so is to create
a special term in PowerSchool specifically for the final exam. The Final Exam term could not
have the same dates as any other term; the PowerSchool administrator would need to take care
that the terms do not overlap. He or she might make the final term exist for a single day. Then
term weights for a semester could be set up so that Quarter 1 = 45%, Quarter 2 = 45%, and the
Final = 10%.

Category Weights

The third way to calculate the final grade is to use Category weights. This method multiplies the
total number of points by the value (or weight) of each category.

This option is available at the shorter term levels. This method allows you to set up the weights
for each category according to your personal plan or school requirements.

Regardless of how you choose to setup your final grade weight factors, it is best to establish
your method before classes begin, and stay consistent throughout the term. This will help
minimize confusion for parents and students as they monitor student progress using Parent
Access. You do, however, have the ability to modify your final grade setup at any point during
the term if you find that your initial plan needs adjustment.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 16
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As part of the Grade Setup, remember to:

1. Record the details of the setup so you'll be able to recall and explain how the final grade is
calculated.

2. Communicate how grades are calculated to students and parents.

Final Grade Setup

Final grade setup determines how the PowerTeacher gradebook calculates final grades. The
final grade is calculated continuously throughout the term so you and your students always
know the final grade.

In the exercise below, you will practice going through the Grade Setup process.

1. Click the Grade Setup tab.

2. The main window of the PowerTeacher gradebook is divided into two panes. The upper
pane shows icons representing the years and terms as they were set up in
PowerSchool. The lower pane contains a set of radio buttons you can select to
determine the final grade setup. (Note: if you do not see the terms you wish to work
with, select a different term from the menu above the class list on the left.)

3. Select a term to work with by clicking it in the upper window.

4. Choose a method for final grade setup and refer to the table below to enter information

in the fields:
Choose whether you would like to drop low scores and
the number of scores to drop. (Note: It is probably best to
choose to drop a number of assignments after several
have been created and scores. To do so too early may
Total Points make it harder to interpret the final grade.)
Term Weights — When you select this option, the dependent terms appear
Note: ) , in the table in the lower half of the "Calculate final grade
ote: Term Weights is S
using:" pane.

available at the Semester
Term level, not the Quarter  Click on one of the terms.

Term level. : :
Weight: Enter a whole number to represent the relative
value each term is to have on the final grade. For
example: Q3 =45, Q4 = 45, Final = 10
Percent: The percent will be calculated automatically.
Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 17
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Category Weights — When the Category weights option is selected, it is not
terms, but assignment categories that appear in the table.

Choose which categories to factor in the final grade by
clicking "add category" on the left below the table. The
Select Categories window will appear. Select the
checkbox for each category you want to factor in to the
final grade calculation. All assignments that are in this
category will be included in the final grade calculation —
unless the "include in Final Grade" checkbox was left
empty when you created or modified the category. (In that
case, assignments in the "not counted" category won't
figure in to the final grade calculation, no matter how
much weight you give it in the Grade Setup.)

Set up the weights for each category according to your
personal plan or your school requirements. To change the
weight from 0, click in the weight column and enter the
desired value. Use the Drop Low column to indicate how
many low scores in each category to discard.

Setting up Student Groups

Teachers know that students arrive on the first day of school with different needs and readiness.

Often, teachers use grouping techniques to help them increase their ability to adapt instruction
to the particular needs of students. PowerTeacher gradebook supports student grouping
practices by providing tools for creating groups and choosing students to include in those
groups. Because student needs change, student group assignments are flexible; they can be
modified any time.

Definitions

* Entire Class — default PowerTeacher gradebook group.

* Set — a collection of groups, i.e. Math or Reading. You must create the Set before you
can create a Group.

* Group — a small collection of students, i.e. Math1, Math2, Math3 or Bluebirds and
Redbirds.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates.
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Creating a Set and Groups

1. Click the Students tab.

2. Click the Plus button (+) in the lower left hand corner of the PowerTeacher gradebook
window.

PowerTeacher gradebook will automatically create Untitled Set 1 and Untitled Group 1.
Double-click on Untitled Set 1 and enter a name for the Set, such as Reading. Press
the Enter key.

5. Double-click on Untitled Group 1 and enter a name for the Group, such as Early
Readers. Press the Enter key.

Click the Plus (+) button again and click Group.

Enter a name for your group and press the Enter key.

Repeat steps 2-7 until you have two sets and at least three groups in each set.

how

© N

Adding Students to a Group

1. Click the Students tab, and click on a student’'s name.

2. Drag the name of the student to the appropriate group.

3. Add students to each of the groups you created. Notice that you cannot add a student to
more than one group of a set, but that you can add them to more than one group if the
groups are in different sets.

4. When you click on the name of a group, the names of the students in the group are
highlighted in the main window pane.

5. You can delete a student from a group by clicking the student’s name in the group list,
then clicking the Minus button (-) at the bottom-left corner of the PowerTeacher
gradebook window.
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Moving Students Between Groups

A student cannot be in more than one group of a set, but you can transfer a student from one
group to another.

1. Click the arrow to the left of the group name to open the group and display the names of
the students in that group.

2. Click the name of the student you would like to move and drag it to the folder for one of
the other groups.

Hands-On Activity

1. Practice adding a set and two groups on your own.

Click the Students tab.

Click the Plus (+) button in the lower left hand corner of the PowerTeacher
gradebook window. An Untitled Set 1 and Untitled Group 1 will appear.
Double-click on Untitled Set 1 and enter a name for the set. Press Enter.
Double-click on Untitled Group 1 and enter a name for the group. Press Enter.
Click the Plus (+) button again and click Add Group.

Enter a name for your group and press Enter.

2. Enter the student groups you use in the following table. This will facilitate an easy setup
of your gradebook next year.
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Setting PowerTeacher Gradebook Preferences

The Preferences window is quite simple. Use it to indicate how you want grades to be
calculated and stored.

1. Click the PowerTeacher Gradebook menu (Mac) or the Tools menu (Windows) at the
top of the screen, and select Preferences.

2. Choose the options that meet your preferences or your school’s policies.

* If you choose the Rounded option, then a grade of 89.75% would be rounded to
90%.

* If you choose the Truncated option, the same grade would be calculated as 89%.
* You can choose to store grades with up to 5 decimal places.

®OC Preferences

When calculating a grade the value should be:

o) Rounded

" Truncated

Store calculated grades withupto: 0 = ‘ decimal places

( Cancel (__QK_)

Viewing Gradescales

Your school’s gradescale is determined by your PowerSchool Administrator.

1. Click the Tools menu, and click Gradescales.
2. Your school Default gradescale will be viewable in a floating window.
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Class Info

The Class Info tab contains basic information about the course you selected in the Classes
pane. You can enter text in the Description field to communicate with parents about class rules

and your expectations of students, to give an overview of the course and any other information
that would be of interest to parents.

1. Click the Class Info tab at the top of the screen.

2. In the Description box, type the information you would like parents to be able to view.

3. Click the Add Web Link button to add a link to a web site that would be helpful to
parents (such as a page displaying the school's Internet policy).

Course Name: English 1 Term: 2006-2007
. ‘ Section Number: 4 Start: 09/01/2006 Fri
Periods/Days: 3(B) End: 08/30/2007 Thu
Room: 115 Grade Scale: Default
Description: |English 1 is a literature course divided into five units of -

study. Each unit has three parts: Reflection Form, Quiz,
and Second Look.

The Reflection Form allows students to make
interpretations of the fiction they are reading by providing
a written essay answers to 3-5 questions.

The Quiz will consist of 15-20 questions on the texts
that they are reading in the unit, and will be taken in class.

The Second Look allows students to reevaluate initial
responses on the Reflection Form, based on class
discussion.

hd
~ 1 . RN} 1 1 B - . 1

Add Web Link

Add Web Link

Add Web Link
Add a web link to class description.

URL: http://whatsthatbug.com

Link Text: What's that Bug

@ Open this link in a new browser window

I Cancel . (_'kOK )
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Creating an Assignment

Some teachers enter new assignments when they are ready to record the scores for that
assignment; others enter new assignments when the assignment is given to the students; and
still others like to set assignments up at the beginning of a school term. Whenever you add
assignments and save your data, the new assignment information can be made available to
parents or guardians and students immediately, if you choose.

After each assignment is created in the Assignment tab, it will show up in the Scoresheet. The
name, point value, and date due for each assignment appear above the column in which you
will enter student scores. Double-clicking on the assignment heading (or clicking the arrow at
the top) will take you back to the assignment page where you can modify the assignment or its
publish criteria.

As you enter assignments into PowerTeacher gradebook, you will notice a demarcation line that
indicates where future assignments are located versus past assignments. This will help orient
you on your spreadsheet, and keep you from scrolling forward to future assignments each time
you open your gradebook

Entering assignments as they are given to students helps to facilitate home/school
communication. If you assign a large project to your students that will be due in one month, you
can enter this assignment into your gradebook as soon as you announce it. You can enter an
assignment description, along with the due date and the total points possible, so parents or
guardians can monitor their student’s progress on the assignment. Students can monitor
missed assignments themselves by logging on to PowerSchool.

Having assignments posted before entering scores does not skew how grades appear. The
Final Grade that appears next to the student’'s name on the Scoresheet reflects an average
grade for only the assignments that have already been scored.

Steps for Creating an Assignment

1. Click the Plus (+) sign next to the Assignment header at the top of the Scoresheet to
open the New Assignment pane. (Or in the Assignment tab, click the plus sign on the left
beneath the list of assignments.) The New Assignment pane will open in the lower half of
the window.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 23
Gradebook Al rights reserved.



PowerSchool

06 PowerTeacher Gradebook: Anthony Perelli - Apple Grove High School 1
Classes ||| |© . ~ ~
. & ~
“Current... = , > % WF’ \ h ‘ |
: i e \ =
Leoaily - -
:L‘ 3(A) First Aid Scoresheet Assignments Students Grade Setup  Class Info Reports
L\ 4(A) First Aid Filter By: Reporting Term: S1 % ! Category: ALL I !
([“ L(8) First Ald Name Abrv Category ¥ Points Possible Weight Date Due
) 2(®) First Aid S[Chapter 1 2 Chapt... 1y Test 50 1.00 07/26/2007 Thu
Chapter 1_1 2 Chapt... [1 Quiz 25 1.00 07/19/2007 Thu
{ & <> |chapter 1.2 D Chapt... [i] Homework 10 1.00 07/19/2007 Thu
_Student Grouplil|Reading test © Readi.. |1 Diagnosti.. 10 1.00 07/09/2007 Mon

IEntire Class
|

New Assignment

Assignment Publish

Name: »»] Abbreviation:
Category: _ -not specified- T‘ Score Type:  Points
Points Possible: AlOU Weight: >LOO
Date Due: 07/27/2007 Include in Final Grade: @

=)

Description:

Revert ] l

Save

2. Refer to the table below as you enter information into the fields:

PowerTeacher

Name

Provide the assignment title

Abbreviation

The abbreviation will be auto-filled with the name of the
assignment. You can change the abbreviation to something

that makes sense to you.

Category

Assign a category to the assignment from the list of categories
created previously. If the assignment does not fit into any of the
categories, create a new one — just take care to not overdo it!
Too many categories can become cumbersome. Limiting the
number of categories you have to less than ten is probably a

good idea.

Score Type

PowerTeacher gradebook automatically displays the score type
you selected for this category. You can change the score type,
if desired. Remember the advantages of being consistent in
how you represent student scores. It's hard to compare unlike

values.

Points Possible

PowerTeacher gradebook automatically fills in the default value
you designated for this category. You can change this value by

Working with PowerTeacher
Gradebook
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entering a different number of points.

Assign a weight to an assignment if it is worth more than other
assignments.

CAUTION! Keep a careful record of changes you make to the
weighting of individual assignments and note how assignment
weighting interacts with category weighting.

A good rule of thumb is that if the assignment is to count more
toward the final grade, make the assignment worth more points
Weight rather than changing its weight.

Indicate a due date for the assignment, if appropriate.

Assignments that are used for diagnostic purposes, for

example, may not need a due date. The default due date for
Due Date assignments is today’s date.

Place a checkmark in the box if the assignment counts toward
the final grade. Drafts and diagnostic assessments would not
Include in Final Grade be included in the final grade.

Enter a general description and specific instructions for the
assignment. Try to be clear enough that students who missed
school the day the assignment was given can complete the
work when they return, without a lot of explanation from you. If
you would like to have students use the Internet as part of the
assignment, you can link to online resources by using this
HTML code:

<a href=enter web address here
Description target= blank>click here</a>

3. Click Save in the lower right corner to save the assignment. The assignment will appear
in the Scoresheet. Details about the assignment will appear in the column heading for
the assignment.

NOTE: Remember to click the plus sign time each time you are creating a new
assignment. When you are creating several assignments in a row, you cannot simply fill
in the fields with new information and save. Doing so would overwrite the existing
assignment.

4. To delete an assignment, highlight the assignment you would like to delete by clicking on
its heading, and click the Minus (-) button next to the assignment header area. A dialog
box will appear asking if you really want to delete the assignment. A similar dialog box
appears if you have already entered scores for the assignment. Be very careful about
deleting assignments; this action cannot be undone.
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How can assignment weights help you?

When creating an assignment, the Weight field can be used to help keep grading
practices flexible, yet consistent. When you set up assignments, consider how you will
score the assignment, then use Points Possible and Weight to make recording scores as
easy as possible. For most assignments, keeping the Weight at the default value of
1.00 and using Points Possible to adjust how the assignment contributes to the
overall term grade will be appropriate.

Example 1: If you want all quizzes to be worth 100 points, yet be able to administer
quizzes that have different numbers of questions, you can use weighting as a way to
make grade entry easy. In this case, you could enter the number of questions correct in
the PowerTeacher gradebook, and use Weight to make the assignment worth 100
points.

* For a quiz containing 20 questions, you would use a weight of 5.
* For a quiz containing 25 questions, the weight would be 4.
* For a quiz containing 10 questions, the weight would be 10.

For a quiz of twenty questions,

* set the points possible at 20
* set the assignment weight at 5
* enter scores out of 20 points possible

Behind the scenes, PowerTeacher gradebook will multiply each point earned by 5. In
this case, if the student scored 16 out of 20, the assignment score is 16 points x 5
weight = 80 weighted points.

Example 2: When using letter grades, you can use weights to ensure that the values for
different types of assignments are correct. You can make projects the highest value
assignment, tests worth less value, and homework worth even less value, by using
weights.

e Make the default value of all assignments 10 points
*  Weight every homework assignment at 1

*  Weight every test at 2

*  Weight every project at 3

When scoring assignments, you will not have to be concerned with points. Simply enter
the letter grade for each assignment, and weighting will automatically take care of the
relative value for each assignment.
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Hands-On Activities

1. Create two or three additional assignments for use later.
* Click the Plus (+) sign next to the Assignment header to open the New
Assignment pane.
e Enter the necessary information into the fields.
* Click Save in the lower right corner to save the assignment. The assignment will
appear in the Scoresheet.
* Repeat the steps for the second assignment.

2. Use weighting to make a set of three quizzes worth 100 points, regardless of the
number of questions each contains. Create three or more quiz-type assignments. Use
information in the grid below to fill in the number of points and weighting fields.

10 10 10 100
20 20 5 100
25 25 4 100

Using weighting on assignments makes it possible for a teacher to simply enter in the number of
correct answers on the scoresheet and let PowerTeacher do the calculations.

3. Think about different ways to set up your assignments in the gradebook using weighting
and points.

4. How could you create an assignment for just one group?
* Create a new assignment.
* Enter the scores for the students in the group.
* Mass fill Exempt for the rest of the students.

5. Enter the descriptions you will use for your Assignments so the objectives and
expectations can be understood by parents and students.
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Publishing Assignments

Publishing the assignment makes it possible for parents and students to see it in PowerSchool
Parent Access. You can publish an assignment at the same time you are creating it, or at any

point afterward.

1. Click the Publish tab in the assignment pane.

t)

New Assignment

Assignment Publish

, \ Publish Assignment:  Immediately i3 ‘

0

Publish Scores: IZ[

2. PowerTeacher gradebook defaults to publishing assignments to the Parent Portal as
soon as they are created. If an assignment is part of the student’s final grade, it must be
published at some point to the Parent Portal. You will receive an error message if you
choose the "Never" publish option for an assignment that is to count toward the final

grade.

3. Refer to the table below as you enter information into the fields: Consider when you want
parents and students to know about the assignment and when you want students to be
able to begin work. Sometimes you'll want to publish the assignment long before it is

due.

4. Once students have completed the assignment and you have entered scores, you can
return to this part of PowerTeacher gradebook to publish scores. Note that parents can
see only their own child's scores and students can see only their own scores.

Publish Assignment

Choose whether you want to Publish Immediately, On a Specific
Date, or Days Before Due.

On Date

Choose the date you want the assignment published.

Days Before Due

Choose the number of days before the assignment is due that
you want the assignment published.

Publish Scores

Place a checkmark in this box if you would also like to publish the
scores for the assignment.

Working with PowerTeacher
Gradebook
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Click Save. Details about publishing to the Parent Portal will appear in the heading of the
assignment on the Scoresheet. A blue circle with an hourglass will indicate that you chose
to Publish the assignment at some time other than "Immediately." A circle with a line
through it indicates that the assignment will never be published. An exclamation point
indicates the scores will not be published.

PowerTeacher Gradebook: Anthony Perelli - Apple Grove High School 1

[ 3(A) FirstAid 5| Scoresheet
Q 4(A) First Aid 5| Filter By: Reporting Term:

'u?\‘:sﬂu

Grade Setup  Class Info

3 Category: ALL

) u® FirstAid S

;:! Students: Active B:

() o
) 2 FirstAid s ®
+| 5~ -~ ~N O~ ~
o 9 (=} =3
—) E 58 |78 |78 B
- R ro e (o e
Situdent Groupl E g2 g 9K '3'. = 53 a
i 8~ ~~ - - o
Entire Class Student Final Grade (S1) ||| MR 5 5 ‘g. gg R '3
Bowles, Ben 9 23 a
Rurlainh H R 2N 1
& Summawr 11
H Save
Q Chapter 1 =
Publish Assignment: ~ On Due Date B:
On Date:  MmM/DD/YYYY =
Days Before Due: 3
Publish Scores: 8
_sveh )
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Copying Assignments

If you teach multiple sections of the same course, and assignments are similar across sections,
you can copy assignments from one class to another within the current term.

1. Create the assignment in one section of the course.

2. Right-click (or control-click) on the assignment, and click Copy Assignment. Or, click
on the Tools menu, and select Copy Assignment.

Copy Assignment

20 Delete Assignment
21

19 Fill Scores

18 Clear Scores

20 35

24 9 48

25 10 50

3. Inthe Copy Assignment dialog box, place a checkmark next to the name of the class
you would like to copy the assignment to.

4. Click the OK button.

®0on Copy Assignment

Copy Assignment
Copy an assignment to the selected classes.

Copy Assignment: Chapter 1_1 from Class: 1(A) First
Aid S1 to the selected classes.

Semester 1 -

Classes

E} same class

™ I 30 First Aid <
) 4(a) First Aid -
O [ ue FirstAid o
[ 2@ FirstAid -
Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 0

Gradebook Al rights reserved.



PowerSchool PowerTeacher

Recording Scores

After you collect and grade an assignment, enter the scores the students earned on the
Scoresheet.

1. Click the Scoresheet tab.

2. Click in the cell representing the intersection of the row containing a student’s name and
the column of the assignment you want to score.

3. Enter scores that match to the type of score you set up when you created the
assignment; numbers for points and percentage, letters for letter grades. If you would
like to mark an assignment Exempt, type EX into the cell on the spreadsheet.

4. Press Return (Mac) or Enter (Windows) to advance to the next student, or Tab to
advance to the next assignment.

5. When you have finished entering scores, click Save.

6. In the event that you accidentally overwrite scores by entering values in the wrong
assignment column, click Revert.

Fill Scores

If a majority of the students in your class got the same score on an assignment, you can use the
Fill Scores tool to quickly enter student scores.

1. Click the Scoresheet tab.

2. Right-click on the assignment details in the column heading, and select Fill Scores. Or,
click on the Tools menu, and select Fill Scores.

3. Choose to Fill Empty Scores for the assignment, or to Replace All Scores for the
assignment.

4. Mark the assignment Collected, Late, Exempt, or enter the Score for the assignment.
Click OK.

Editing a Score
Change a score you entered earlier.

1. Click the score, drag over it to highlight it and type the new score over it, or delete it and
enter a new score.

2. The score will appear highlighted in gray until you click Save to save the changes you
have made.

3. If you want to change the Score Type, select the assignment and open up the
assignment detail pane by clicking the arrow at the top right of the column heading.
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Make changes as needed. Click Save.

Making changes in the score type will cause PowerTeacher gradebook to convert the
scores you entered automatically. Making changes affects the display of scores, but not
their value. The final grades are not changed.

Changing Points Possible

Occasionally you will create an assignment and set the points possible, then determine that the
actual assignment has a different number of points possible. Perhaps the assignment you
originally envisioned was different from the actual assignment. For example, imagine that you
created an assignment in PowerTeacher gradebook worth 100 points, but scored student work
based on a maximum total points possible of 50. You would need to change the points possible
for the assignment.

1. Open the Assignment Detail pane of an assignment that has already been scored by
clicking the Expand button at the top of the assignment’s column heading in the
Scoresheet.

2. Change the value in the Points Possible field to 50 and click Save.
3. As soon as you click Save, a warning will appear. If you know the scores you have
entered are correct and do not need to be changed, click OK.
Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 32
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Using the Score Inspector

The Score Inspector is a tool in PowerTeacher gradebook that provides the ability to note if an
assignment was received late, if a student is exempt from completing the assignment, and even
that you’'ve collected the assignment without entering a point value. You can also use this tool
to enter a score comment.

1. Click the Tools menu and click Score Inspector. (Right-clicking — or control-clicking on
a score also makes the Score Inspector available.) The Score Inspector will appear as a
floating window that you can move around the screen.

Score Inspector x|

Student: Kathryn Christen... & w
Assignment: Unit 1 - Reflectio... 4 »
Scoring Type: Points

Collected: |~  Late: [

Exempt Score: |

Score: ]SE»

Points: 56,/100
Percent: 56%b

Grade: F

Comment:

l Clear i

2. Click a cell in the assignment column on the Scoresheet for the student you wish to work
with.

* When you check the Collected box in the Score Inspector, a checkmark will appear
in the Scoresheet for the student.

* When you check the Late box, a small red L will appear in the Scoresheet for the
student.

* When you check the Exempt Score box, a gray Ex will appear in the Scoresheet for
the student.

* When you enter a score comment, a small blue C will appear in the Scoresheet for
the student. Clicking on the Comment Bank button will provide you with a list of
district comments that can be inserted for a score.

3. The Clear button on the Score Inspector clears the score completely, not just the
comment or a Collected check or Late indicator.
4. You can use the four directional arrows in the Score Inspector to move through the

Scoresheet without closing the Score Inspector. This enables you to adjust scores, add

comments, and add collected, late, and exempt notes to scores for all the students in
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your class without having to click each student one by one.
5. Click Save at the bottom of the Scoresheet to retain changes.
Legend for PowerTeacher Score Indicators
| . © o ©
|9 g ©
&+ g - .g - 2 a e
-| T8 o3 &
J eo~ 85~ 2
: 2r8 |22 |2
Student FinalGrade(51) ||| 88 <S58 =
Ackerman, Stan © B 85% 10 7
Bachman, Sarah & IS ol 9 | 9| 9
Byers, Sarah D A- 95% ] 104
Castillo, Randy @ A- 90% 9 v
Cox, Sara e B- 80% 8 1
Ekstrom, Joshua 2 A 100% 10 10
Frost, Rachel o A- 100% ! 10
Hagen-Weis, Alexa... &  A- 95% 10 9
Heap, Nikolas © B 85% 7 10

Indicator Description

Indicator Meaning

Small “c” in blue dot next to score

There is a comment attached

Small “L” in red dot next to score

Assignment turned in late

Green check in a cell

Assignment turned in but not graded

Italicized faint score

Assignment does not count toward final
grade OR was marked as exempt after
scoring. (If marked Exempt with no score,
Ex appears in gray.)

Small Hourglass in assignment heading

Assignment published on certain date

Circle with line through it in assignment
heading

Assignment is never to be published

Small red exclamation mark next to
italicized final grade

Final grade changed by manual override
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Override Final Grade

Occasionally, teachers will want to modify a student’s final grade in a course — based on effort,
participation, or other classroom factors. The Score Inspector allows you to change a final
grade with the Manual Override tool.

1.
2.
3.

Highlight the Student’s Name or the Final Grade cell to the right of the student’s name.
Click the Tools menu, and click Score Inspector.
Place a checkmark in the box next to Manual Override.

r S |
e Score Inspector

k

Student: Lloyd U Johnson & w

Reporting Term: 51

Manual Override: z
Percent: 72

GCrade: C
Points: nfa
Comment:

| have changed Lloyd's grade from a C-
to a C because he has consistently
participated in class discussions and
has completed two extra credit pru:ujeu:ts.|

Once you check the Manual Override box, the Grade and Percent boxes become
available. Change the contents of each of these boxes as desired. Once the grade is
changed manually, it is displayed in italics on the Scoresheet. Also, a red exclamation
point (!) is placed in the Final Grade cell indicating that you made a manual change to
the student’s final grade.

Click Save in the lower right corner of the Scoresheet to save your changes. Click
Revert if you would like to change scores back to their original values.
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Hands-On Activities

1. Record scores for assignments you created.
* Press Return (Mac) or Enter (Windows) to advance to the next student, or Tab to
advance to the next assignment.
* When you have finished entering scores, click Save.
* In the event that you accidentally overwrite scores by entering values in the wrong
assignment column, click Revert.

2. Use the Score Inspector to add score notes, and to mark assignments collected, late,

and exempt.
* You can use the four directional arrows in the Score Inspector to move through the

Scoresheet without closing the Score Inspector.
* Click Save to retain changes.
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Output — Scoresheet, Statistics, and Reports

Once you have entered your assignments and the resulting scores into the PowerTeacher
gradebook, you have a variety of ways to view the scores.

Filtering the Scoresheet Display

After using the PowerTeacher gradebook for some time, you may have created and scored
many assignments for each class - more assignments than will fit on your computer screen.
When you launch PowerTeacher gradebook, the Scoresheet automatically opens displaying the
first few assignments you created with later assignments visible only when you drag the
scrollbar at the bottom of the pane to the right.

1
/

—% i \f> TS

Scoresheet  Assignments  Students  Grade Setup  Class Info Reports
Filter By:  Reporting Term: |Q4 v I Category: IALL ¥ ] Students: IActive v I
- ‘3 e e =5 _g e ‘3 o s _g e e
[+ & N S & o S
=25 g 4y Zs  E&p  dp
Student FinalGrade () ||| | 59 £ S8 |S5S8 |S58 [S588 [58%8
Christensen, Kathryn & A 6% 56 v 100 25 95 87 25 v
Garner, Justin 2 A- 91% 56 v 70 73 81 25 v
Gines, Brieann 5 A- 90% 56 v 638 25 96 75 24,5 v
Hallock, Kayla D A 0% 91 v i 25 91 i v
Pettus, Carolina & B+ 89% 69 v 99 25 39 25 v
Philipoom, Andrea @ B 86% 85 voa 79 23 73 25 v
Ritland, Dale 5 C+ 78% 63 v 65 25 65 62 25 v
2 Summary | i <J ]

By scrolling through the Scoresheet you can see all of the assignments in chronological order.
However, by filtering assignments by category, and highlighting a student’s name, for example,
you can quickly determine if there is a pattern or trend in his or her performance. Are their
grades staying consistent over time? Are they falling? Improving?
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Filter assignments by using the pop-up menus that appear between the navigation bar at the top
of the PowerTeacher gradebook window and the assignment heading.

- AR

Scoresheet ~Assignments Students Grade Setup Class Info Reports

Students: Active *3‘

a
v

Filter By: Reporting Term: This Month | § ‘ Category: »;\LL

l

|| Diagnostic Tests o
i) Homework
+ —‘K‘ . S
— - \ Project ' 8
51 Quiz 5o
%K\‘ Test | :
Student Final Grade (Q1) ||| S ora oG S &
Bowles, Ben © B 75% o 23 10 45
Burleigh, Heather D @ C- 70% 20 7 44

* Filtering by Reporting Term — The menu on the left filters the assignments by
reporting term. The setup of the years and terms at your school is determined by
your PowerSchool administrator. Choosing a term or a portion of a term (week or
month) will determine which assignments are displayed. Assignments with due dates
falling between the start and end dates for the term (or time period) you select will
appear in the Scoresheet.

* Filtering by Category — The category menu will allow you to choose to limit the
display of assignments to one category. The default display is ALL. Open the pop-up
Category menu to see all of the categories you have created. Filtering by categories
is one way to get a sense of how students are doing on that type of assignment.

* Filter by Students — You can filter your spreadsheet to show only students who are
active in the class, those who have dropped the class. The spreadsheet defaults to
active students.

Note: When you have a filter in place on your spreadsheet, and are ready to switch between
classes, the filter will carry over to the next class you view so that you see the same term,
category and group of students (active vs. dropped).

Assignment Statistics

PowerTeacher gradebook provides you with tools to view trends and to analyze your students’
scores mathematically. Assignment statistics provide information on each assignment you enter
into the gradebook.

To view the Statistics Summary, do the following:

1. Click the Summary button in the lower left corner of the Scoresheet to see the mean,
median, and mode values for each assignment.
* The mean is the mathematical average of the scores you entered.
e The median represents the middle of all values: one-half of the scores will be
above this number and one-half will be below it.
* The mode indicates the most common value.
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How can assignment statistics help you?

All of these values are indicators of how well your students did on the assignment. If any
one of them is unexpectedly low, it may be that students need additional practice on the
skills and concepts being assessed, or the assessment needs to be revised.

So, how can this information help you to better analyze your students’ results on an
assignment? Below are three examples.

Here are scores from a Vocabulary and Spelling test.

2
[}
%3
=
»
o
£
T
Student Final Grade (Q4) ||| B3
Bailey, Jenilyn Q cC 2%
Bevan, Adam @ F 56%
Brito, Jordan 2 A 95%
Bushman, Joshua @ B 84%
Emch, Felicia <2 D+ 67%
Gilbert, Isaac 2 B 80%
Kakac, Brittney & C+ 78% 78

D 64% 64
C 75% 75
C+ 78% 78
D 65% 65
F 35% 35
D- 62% 62

Kern, Jennifer
Krsnak, Jordan
Leftbear, Joseph
Mai, Lee
Montplaisir, Aaron
Muffer, Brandon

ODO000OODO00OOO
M

MNyberg, Lucas 74% 74
Odney, Ian B 34% 84
Olsgaard, Nicholas B- 81% 81
Smith, Kade & 99% 99
Willis, David C- 70% 70
Wright, Audrey C+ 78% 78
‘Wright, Jennifer D- 60% 60

Mew Assignment ~ Delete Assignment

This is a “normal distribution” of scores because most of the scores are clustered around
the mean, with fewer scores at the extremes.

* Mean (average score) is 72.8 — which is a C.
* Median is 75 — there are ten scores 75 or higher and ten scores with a value
below 75.

* Mode is 78 — there are three 78s, but no more than two for any other value. In
the case where there is a tie between most common values, the Mode cell will be
empty.
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Example 2: Struggling Students

It is possible to have the average grade for the class be a C while having the spread of
scores much wider. This indicates that while some students are doing very well, more
may be struggling. Look at these scores on the Vocabulary and Spelling test.

-n:

]

o

o

>

o

£

o
Student Final Grade (Q4) ||| B3
Bailey, Jenilyn ®Q a 100% 100
Bevan, Adam Q A 100% 100
Brito, Jordan © a 100% 100
Bushman, Joshua 2 B 80% 30
Emch, Felicia © F 57% 57
Gilbert, Isaac 5| A 90%
Kakac, Brittney ® a 98% 93
Kern, Jennifer @ B 82% 82
Krsnak, Jordan © D 65% 65
Leftbear, Joseph ® C+ 78% 78
Mai, Lee © B 86% 86
Montplaisir, Aaron © F 20% 20
Muffer, Brandon ® F 56% 56
Myberg, Lucas @ D 64% 64
Odney, Ian © B 34% 34
Olsgaard, Micholas Q A 100% 100
Smith, Kade ® F 24% 24
Willis, David ® c 70% 70
Wright, Audrey 2 D+ 68% 63
Wright, Jennifer ® D 60% 60
. z Summm\;‘y. ’]||i‘

¢ Meanis 74.1 —whichisa C
¢ Median is 80 - because half of the students received scores of 80 and above
* Mode is 100 - four students got a score of 100 on the test

How is this different from the “normal distribution” scores in Example 1? How can you
analyze this information to determine if your students are doing well or doing poorly?

If you only looked at the mode value, you might think that students were doing very well.
However, the median is 80, higher than the Example 1 scores. When the median is
several points higher than the mean, then the half of scores below the median must be
very low to drag the mean down significantly. In this case, the implication is that half of
the students mastered the material covered in the assignment, but the other half did not.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates.
Gradebook Al rights reserved.

40



PowerSchool PowerTeacher

Example 3: Retaking the Quiz

If you decide to work with the students in peer groups to help improve their Vocabulary
and Spelling Quiz scores, how would you know if their scores improved? How would
you be able to analyze whether this was a valid teaching method? Below are scores for
the students after re-taking the quiz.

Student Final Grade (Q4) |||

Bailey, Jenilyn Q A 100% 100
Bevan, Adam @ A 100% 100
Brito, Jordan Q A 100% 100
Bushman, Joshua 2 B 80% 80
Emch, Felicia @ cC 75% 75
Gilbert, Isaac 2 A 0% a0
Kakac, Brittney Q A 98% 93
Kern, Jennifer 2 B 82% 82
Krsnak, Jordan @ D 65% 65
Leftbear, Joseph 2+ 78% 78
Mai, Lee @ B B86% 86
Montplaisir, Aaron Q@ cC 76% 76
Nuffer, Brandon Q C 0% 70
Nyberg, Lucas 2 D+ 68% 68
Olsgaard, Nicholas Q A 100% 100
Smith, Kade 2 C+ 78% 78
Willis, David @ cC 70% 70
Wright, Audrey @ C+ 78% 78
Wright, Jennifer 2 C 72% 72

In this example, all twenty of the scores lie in a “passing” distribution.

* Mean is 82.6 - higher than in either of the other two examples because there are
fewer D and F scores, indicating that there is a narrower range of scores.

* Median is 80 - because half of the students received scores of 80 and above

* Mode is 100 - four students got a score of 100 on the test

Score distributions like this demonstrate that there is not a subgroup of students who are
struggling, but that everyone is somewhat successful on the assignment.
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Hands-On Activity

1. Explore the filtering options available on the Scoresheet. How will these tools help you
analyze your student’s progress in your course?

2. Explore the Summary Statistics area on the Scoresheet. How will this information help
you analyze your student’s progress in your course?

PowerTeacher Gradebook Reports

The reports available through PowerTeacher gradebook allow you to have a paper or electronic
copy of information to show the principal or a parent. There are seven types of reports
available, and they can be presented in three output types:

PDF — a cross-platform file that can be read and printed by Adobe Acrobat Reader
or Preview on a Mac or PC.

HTML — a file that can be read by a browser such as Internet Explorer, Firefox, or
Safari.

Text Export (csv) — a text file consisting of the data, separated by commas. This file
can be opened with Excel or another spreadsheet software application.

To use the available reports, follow these steps:

1. Click the Reports tab.
2. Click the type of report you would like to view.

Attendance Grid Report — can be used to take attendance at field trips or other
out-of-classroom events. It can also be used as a convenient roster for note-taking
during student presentations, or to track class participation.

Category Total Report — a summation of the assignment category totals for each
reporting term. It can be grouped by student and class. This report shows graphs for
assignment count and average score per category.

Final Grade and Comment Verification — a report showing final grades and
teacher comments for students grouped first by section, then by term.

Individual Student Report — a report that lists section scores by assignment, and
the final grade for each reporting term, listed in a one page per student layout.
Missing Assignment — a report that lists assignments that are missing per
assignment or per student. The output for this report can be in PDF, HTML, or CSV
formats.

Scoresheet — allows you to view final grades for all reporting terms, and
assignments that are within a specific date range, for all students.

r
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e Student Roster — a report that allows you to specify which columns of student data
to list on the report, and in what order, each time the report is run.
3. Options for configuring the report appear in the lower pane.

WG E e

Scoresheet  Assignments  Students  Grade Setup  Class Info Reports

MName: A Description:
Attendance Grid & |Student and date grid template for taking attendance

i

Category Total Report ) Summary of category totals by section or by student

Final Grade and Comment Veri... © Final grades and comments by reporting term

Individual Student Report © Summary of class activity per student

Missing Assignment ) Listing of assigments that have not been scored

Scoresheet ©) Student grade and assignment data

Student Roster ©) Student demographic information listed one row per s...

(xh= Attendance Grid =

, Name: Attendance Grid
{ Description: Student and date grid template for taking attendance
“ Output Type: & PDF (" HTML
e :’f—;-.” Sections: (% Selected Class ¢~ Active Classes
Students: (¢ Enrolled Students ¢ Selected Student Group(s)

Current Week: [

Start Date: |;
End Date: |1

Run Report

4. Click the Output Option you would like (PDF, HTML, or CSV).
5. Select the appropriate sections, students, and date range for the report.
6. Click the Run Report button in the lower right corner of the screen.
7. The report will be saved in the file type and location you choose on your computer.
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Hands-On Activity

1. Working in pairs or small groups, look at the different types of reports. Create a report
as a PDF, HTML, and Export (CSV) file so you can view the different output options.

2. Write some possible uses for each report in the following table. This will help you use
the information from PowerTeacher more effectively.

Report Name Possible Uses

Attendance Grid

Category Total Report

Final Grade and
Comment Verification

Individual Student Report

Missing Assignment

Spreadsheet

Student Roster
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School Reports

Your school determines what reports can be printed from the PowerTeacher Start Page. These
reports may include form letters, progress reports, and report cards. For information about what
custom reports your school has created, see your PowerSchool administrator.

1. Click the printer icon next to the name of the class for which you want to print a school-
created report on the PowerTeacher Start Page.

Print Class Reports

Wwhich report would you like to print? IClasS Attendance Audit ‘ﬂ
For which students? The 20 students in this class,
Test print? I print only the first |2 pages.
Private %

Watermark Text ——-
Watermark Mode Watermark ¥

) ASAP |
When to print

l =
€ Submit )

Click the desired report from the "Which report would you like to print?" menu.

Check Test print? to verify the report before printing.

Use the Watermark Text pop-up menu to if you would like to print “Confidential,” “Draft,”
or another word in a faint color on the report.

5. If you want the report to print right away, leave the When to print menu at the default,
ASAP. Otherwise, enter a date and time in the boxes provided.

Click Submit.

When you run a report in PowerTeacher, the Report Queue - My Jobs page appears.
Verify the status of your report. If your report is still running, click the word Refresh in
blue in the upper left corner of the screen to update the queue. Do not click your
browser’s Refresh button.

Report Queue - My Jo

Created Job Hame Started Ended Status

robd

No

02/22/2007 02/22/2007 12:22 PM 02/22/2007 12:22 PM

02/22/2007 02/22/20¢

121 AM 02/22/2007 6:21 AM

Job Detail page, which provides additional information about the job, The Job Detail page can also be
cuti

o cancel a job on the Job Detail
rked as canceled, but will

Completed and canceled jobs will automatically be deleted after 90 days. Click on the trash can icon to immediately delete an
individual job, or you can delete all completed or canceled jobs.

8. When your report shows that it has been Completed in the Status column, click
Completed to view the report.

9. To print the report, click the File menu, then Print from the application you used to view
the report.
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Student Information

There are two sources of student information in PowerTeacher. The first source is in the
Students tab in PowerTeacher gradebook. More comprehensive information is available via the
PowerTeacher Start Page. Both sources are described below.

Using the Students Tab

1. Select a class.

2. Click the Students Tab, then click on the name of one of the students.

3. Click the arrow button next to each student’'s name. The student’s demographic
information and picture appear in a new pane in the lower section of the screen.

* Click the icons at the top of the demographic information pane to view alert
information about the student. Click OK to close the Alert window.

* Click one of the phone numbers in blue to enlarge it. The large phone number is
easier to read while using your phone at a distance from your desk. Click away from
the number to make the number disappear.

* Click on the email address to copy the address into an email message to the
guardian.

o= Amanda Schierholz

Student

¥ L4
S ) Name: Amanda Schierholz Student Number: 840002146
L = . Gender: F Grade Level: 10

Birthday: 08/06/1991 Home Phone: 216-555-3237
Father's Name: Jonathan Schierholz  Guardian E-mail: momma@hp.com

Mother's Name: EBrinnan Schierholz
Emergency Contacts:
Jared Ham 281-555-1806

916-555-3502

Using the Backpack Icon

The PowerTeacher Student pages provide information about each student enrolled in your
classes. All of the student pages are accessed in a similar manner.

1. On the PowerTeacher start page, click the backpack icon next to the class information
you would like to view.

2. Click a student’s name in the list on the left side of the page. Your default student page
appears for the student you selected. At the bottom of the list of students, your other
classes will be listed. You can switch class lists by clicking a different class name.

3. At the top of the student screen is individual student information.

e Student Name
e Student Grade Level
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e Student ID Number

e School

e Symbols — Not all symbols will be used for every student, but many students will
have at least one. Click the symbol to see details of the alert information.

Medical Caduceus — Medical Alert — For example: The student is diabetic.

Silhouette — Parent Alert — For example: The student may not leave school
grounds with a parent.

Scales — Discipline Alert — For example: The student is prone to fighting.
Dollar Sign — Fee Alert — For example: The student owes money for lunch.
Candle — Birthday Alert, Today is the student’s birthday.

Warning Triangle — Other Alert, a miscellaneous alert that can be used for any
purpose as determined by the school.

4. To view other student information, choose a student page from the Select Screens pop-
up menu.

Select screens =\

f

Quick Lookup = $

Babb, Judy H 12 10494 AGHS

Selectscreens

de Information

5 Last Week | This Week
Xp
L M|T/WHFMTWHF

1(4)

1(B) |.

2(A-B)

3(A)

3(8) |. ol Il 7Y

4(AB)

' |Berndt

Attendance By Class

Course

Lura, Colleen R

Spanish 2
visitor, Te

Chamb

Current Af
Abram, Mic e
Trigonometry
Taylor, Steven M

Q10251 |03 |04|S52

Demographics

alb, Final Grade Entry (Standards)
Meeting Attendance
Net/Phone Access Summary
Print A Report

Quick Lookup

1p Schedule

Standards

Student Photo

Submit Log Entry

Teacher Comments

o [ [ [N Crades

u} 0 u} 0

Attendance Totals | 10 26 0 0

Current Simple GPA (Q3):

Show dropped classes also

The table below contains a description of each of the screens available in PowerTeacher.

Displays the student’'s GPA and class rank information.
Your school decides what information appears on this

page.

Cumulative Grade
Information

Displays the student’s basic demographic information. It
also contains an email link to the parent/guardian to
make it easier for you to contact the student’s guardian.

Demographics
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Final Grade Entry

Use this page to enter final grades and comments for
specific standards for the student. Your school decides if

(Standards) you use this page and what standards appear on the
page.

Meetin Displays the student’s attendance record for every

Attendagnce course in which he or she is currently enrolled and for

the entire term.

Net/Phone Access
Summary

Displays a summary of the number of times that the
parents and student have accessed PowerSchool via
the Internet or by phone, if applicable.

Print a Report

Use this page to select a school-created report to print
for the student.

Quick Lookup

This is the default student page. Displays a summary of
the student’s current grades and attendance for each
course in which he or she is currently enrolled. Clicking
the blue text will link you to more information.

Schedule

Displays the student’s current class schedule.

Standards

Use this page to view the student’s progress on specific
standards outlined by your state, district, and school.

Student Photo

Displays the student’s photo, if your school has added
student photos.

Submit Log Entry

Use this page to submit a student discipline log entry.

Teacher
Comments

Displays the notes created by each teacher for parents
to see. Use this page to enter or edit a parent note you
submitted.

Term Grades

Displays the student’s grades for each class as they
were stored and reported on his or her report cards
during the current year.

Entering Teacher Comments

You can enter comments on the student’s overall performance in your course. These
comments can be viewed by parents or guardians and students in PowerSchool Parent Access

and on report cards.

1. Click the backpack icon on the PowerTeacher start page, then click the student’s last

name.

2. From the Select Screens menu, click Teacher Comments.

3. Click the blue Edit link next to the class to which you would like to add comments.

4. A school comment bank may be available for your use. You can click the comment in
the bank, and click the arrow to move the comment to the Comment box.

Working with PowerTeacher
Gradebook
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Modify Comment ‘:}E $ ESeIec{sCreens vl
Babb, Judy H 12 10494 B AGHS

Enter or modify the teacher commment for this student below, NOTE: If you are using PowerGrade to record cormrments, changes below
will be overwritten the next time your gradebook is saved,
Course: Current Affairs

Expression: 3(B)

Comment Bank:

Comment:
I 5 - 3 T Jud ks hard in thi
[01] - Needs to be prepared with assigned materials and tools. - c";agsw;;s: o?rth;nc imzs
[02] - Accepts responsibility for own actions. ‘

: 2 She demonstrates critical
[03] - Demonstrates leadership qualities.

[04] - Frequent absence from class has impacted grade. ! E:lzzizgcsi};;iés;aoﬁztiEEEdS
[05] - Is working hard and is making progress. e
[06] - Participates enthusiastically. ~| ¥
f Submit )

5. Additionally, you can type your own comment into the Comment box.
6. When you have finished adding comments, click Submit.

Discipline
You can use PowerTeacher to report discipline issues in your classroom to your school
administrator. Use the Student Log Entry page to enter this information.

1. On the Start Page click the backpack, then click the student’s last name.
2. From the Select Screens menu, click Submit Log Entry.

@ Submit Log Entry % L gt $ ¢ 4 Selectscreens |

Babb, Judy H 12 10494 AGHS

Date 2/22{2007
Subject IFighting

Log Entry [7udy punched Breanna Laughter. Breanna was teasing
Judy, and Judy got upset.

€ Submit )

3. Enter a subject for the log entry, then type a description of the incident that occurred.
4. Click Submit. This action sends the information to the discipline administrator at your
school.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates. 49
Gradebook Al rights reserved.



PowerSchool PowerTeacher

Hands-On Activities

1. Click through each of the Student Information screens to view the information that is
available for each student.

2. Enter a Teacher Comment for two students in one of your classes.

3. Add a Discipline Log Entry for two students who had a discipline problem in your
classroom.

Working with PowerTeacher Copyright © 2007 Pearson Education, Inc or its affiliates.
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PowerSchool Parent Access

PowerSchool's Parent Access provides parents or guardians round-the-clock access to real-
time information about their child’s attendance and grades. It also provides a means for
teachers to communicate with parents or guardians about class events and assignments, and
ways they can help their child at home. Parents or guardians can contact teachers via email —
teachers’ addresses are linked right on the front page. They can also elect to receive periodic
emails with attendance and grade updates, if that method is easier for them than going to the
site.

Getting Started

After your school decides to allow access to Parent Access, the necessary information will be
communicated to parents or guardians regarding how to log on to Parent Access, as well as
information about usernames and passwords. To log on to Parent Access, parents need the
following information from the PowerSchool administrator:

e Address of the PowerSchool server
e Their username and password

Log on to Parent Access

1. Open a web browser, such as Safari, Netscape Navigator, or Internet Explorer, and
enter the address of your PowerSchool server followed by /public in the browser
address bar.

Enter a username and password.

Click Enter.

wn

Once they have successfully logged in to the Parent Access, parents see the Start Page.
Parents of high school and elementary students see identical layouts and identical functionality.

Babb, Judy H, 12
Appla Grove High Sehool~ Apple-Grove School District _Logow”

PowerSchool 3 [_l» s $ -

B :

#
Gradesand  Grades  Attendance Email Teacher School Class
Attendance  History History Notification Comments  Bulletin  Registration

Grades and Attendance

Bxp

Last Week This Week
m[t[wln[r[m[T[w[u[F

1(4)

1(e)

2(A-8)

Current Simple GPA (Q3)
Show dropped classes also

s: Blank=Present | HD=Half Day
xcused | 1=In School Susy
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The Parents' View of PowerSchool

Parents can obtain grades and assignment information from two areas in PowerSchool, the
Grades and Attendance page and the Grades History and Attendance History page.

The Grades and Attendance page provides parents with a list of the student’s current courses,
grades, and attendance for each class.

Attendance is provided in two locations on this page — on the left is the current two-week
period, and on the right is the school year running total. The student’s attendance is
marked on the left for Last Week and This Week. A list of attendance codes appears at
the bottom of the page. This page also provides parents with an accurate running count
of absences and tardies from each class in which the student is enrolled, as well as an
attendance total. Clicking the number of absences or tardies displays the dates of the
absences or tardies.

Current or historical grades for each course in which the student is enrolled are listed
next to the course name on the Grades and Attendance page. Clicking the grade
displays assignment information. This feature helps parents know how the student is
performing throughout the term and helps prevent their getting a surprise when report
cards come home. Parents can see when assignments are due and whether students
are falling behind in their work. Clicking the name of the assignment will provide the
parent with a description of the assignment. If assignment scores display in blue,
clicking the score will shows parents the score comment. There is a note to parents
indicating that the student’s final grade may include assignments you have created but
not yet published.

Babb, Judy H, 12 Logout

Apple Grove High School - Apple Grove School District
PowerSchool ' /3 m = P ¢ =
‘= e O = = y & o
Grades and Grades Attendance Email Teacher School Class Balance My
Attendance History History Notification Comments Bulletin Registration Calendars
Class Score Detail
Course Teacher Expression Final Grade®
Current Affairs Abram, Michael 3(B) B 84%
Teacher Comments:
Section Description:
Due Date Category Assignment Score %  Grd
02/05/2007 HW Secl /10 90 A
02/07/2007 QuIZ quiz 10/10 100 A
02/08/2007 TEST test EX/100
Grades last updated on 2/7/2007
A - Score is exempt from final grade, * - Assignment is not included in final grade
1 - This final grade may include assignments that are not yet published by the teacher. It may also be a result of specia
weighting used by the teacher.
Print Page .
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e If your school enters teacher email addresses in PowerSchool, parents can email
teachers by clicking the teacher’'s name.

The Grades History and Attendance History page displays past grade and attendance
information.

* Grade History displays students grades from previous semesters in their courses for the
current school year.

* Attendance History displays the student’s attendance for an entire term. This page is
similar to the attendance pages in PowerSchool, except that it is Read Only; parents
cannot take or change attendance or make any other changes in the page.

School, Teacher, and Parent Communication

Parents can keep track of upcoming school events, fee balances, and can communicate with
teachers through PowerSchool Parent Access.

School to Parent Communication

Using PowerSchool Parent Access, parents can view the School Bulletin, help students register
for classes, and check fee balances. Overall, these activities facilitate the flow of information
between the school and the parent.

* The School Bulletin displays the public version of daily announcements. Parents have
the opportunity to read about upcoming events, school announcements, and new
opportunities that affect their student. As a result, parents don’t have to rely entirely on
their child’s bringing the information home.

* Class Registration allows parents to help students select courses for upcoming terms.
Often, work schedules prevent parents from coming to school and assisting students
with schedules for next school year. The Class Registration icon is made available to
students and parents during class registration. Parents and students can access this
information at home at a convenient time and discuss appropriate course choice for the
student. Many schools have students make their initial selections on this page.

* On the Balance page, parents can view fees that are due for a student. The Balance
page displays a summary of the fees due to the school for student lunches, activities,
overdue library books, course fees, enroliment fees, etc.
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Teacher to Parent Communication

Parents and Teachers can use PowerSchool Parent Access as a communication tool.

* The easiest method for parents to communicate with teachers is to click the teacher’s
name on the start page of PowerSchool Parent Access and send the teacher an email.

* Parents can read teacher comments about their student by clicking the Teacher
Comment icon. The teacher comments reflect the student’s performance in the class as
a whole, not on a specific assignment or test.

Staying Connected: Subscriptions and Email

Parents can to register to receive updated information by email .

* Email Notification - Parents can keep in touch with their child's class progress and
upcoming school events by registering to receive Email Notifications. Most of the
information parents will receive with the Email Notification is available in other locations
on the Parent Access site, but it is often easier for parents to receive information via
email rather than visiting the site. This information is automatically sent from
PowerSchool to the requested email addresses according to the schedule the parent
chooses.

e My Calendars - Parents and students can subscribe to a teacher’s or the school’s
published calendar using the My Calendars feature. This feature can be used with Macs
or PCs with any electronic calendaring software that uses the iCalendar standard. As
part of the subscription process, parents can name the calendar and determine how
often it is refreshed. Once the parent has subscribed, the class calendar shows up in
the list of calendars to which he or she has previously subscribed or has created.
Parents can also subscribe to the school’s published calendar so that daily bulletin items
will display in their calendaring software.

Hands-On Activity

Browse pages in PowerSchool Parent Access to familiarize yourself with the information
available to parents.

PowerSchool Parent Access Copyright © 2007 Pearson Education, Inc or its affiliates. 54
All rights reserved.



